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32 fEmgt

FPGA BUIZITBEHEATEEERITAT , JWF soMhz BRFATER , — N NITEREIEAE 20ns , BB
A ZF—FPEE 50000000 NHTEEHRD , WNER—ETEEERTEEEEIN—IK , ABAITELEEM 0 FI
49999999 TFHFE2 50000000 NEEE , FE 1 FLAVATED,

FRFHENT— 32 MAJTEES !

//Define the time counter
reg [31:0] timer;

BRAA AR 4294967295 , +/NiHFIFNZE FFFFFFFF , ANRITHERZEISEKE | ATAERR
85.89934592 ¥, FERFIRITHESIR 1 70 LED T —IR , —HiEFE 4 MH—MEFR.

always@ (posedge sys clk or negedge rst n)
begin
if (~rst_n)
timer <=
else if (timer == )
timer <=
else
timer <= timer +
end

. BT, F=R. BOMWERAIEHRS BIEE LED AIRT , BfttEHRERRISFIRE
RIEARZ.

// LED control
always@ (posedge sys clk or negedge rst n)
begin
if (~rst _n)
led <=
else if (timer == )
led <=
else if (timer == )
led <=
else if (timer == )
led <=
else if (timer == )
led <=

end
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4 Vivado ITFs

4.1 SGREETIE

1. 250 Vivado 2019.1 FFAIMS(TEFFIRSZE FI%ERR Xilinx Design Tools->Vivado 2019.1->Vivado 2019.1,

B & W S ERY Vivado 2019.1 FIEFRE T TR,

WinPcap ~
WinRAR
Xilinx Design Tools
(& Add Design Tools or Devices 2...
(& Add Design Tools or Devices 2...
Y Manage Xilinx Licenses 2017.4
i Manage Xilinx Licenses 2019.1
£ Uninstall 2017.4
$: Uninstall 2019.1
ia Uninstall Xilinx Information Cent...
$ Xilinx Information Center

DocMav

Model Composer 20191

SDK 20174

SDK 20194

SDx 20191

Vivado 20174

Vivado 20181

B Vivado 20191 Tl Shell

¢ Vivado 2019.1 | v

2. f£ Vivado 2019.1 FFAIREEENES Create Project , {1 TE :
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Eile  Flow Tools Window Help = ©- QuickAccess

VIVADO!

HLx Editions

Quick Start

Create Project >
Open Project >
Open Example Project >

Tasks

Manage IP >
Open Hardware Manager >
Xilinx Tcl Store >

3. SH— Vivado UTFEAS , /i Next 1&4.

1
Create a New Vivado Proj ect

’
VlVADO This wizard will guide you through the creation of a new project.
HLx Editions
To create a Vivado project you will need to provide a name and a location for your project files. Mext, you
will specify the type of flow you'll be working with. Finally, you will specify your project sources and choose
a default part.

£ XILINX

ALL PROGRAMMARLE

@

4. FESR AR EFMA TSN TEFRNER , XEE— led_test FITIER , M Next,

EEHHX 4/44
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| ¢ New Project x ﬂ

Project Name

Enter a name for your project and specify a directory where the project data files will be stored. ‘

Projectname:  led_test
Project location: |D:/demo E’

Create project subdirectory

Project will be created at D/Demo/led_test

(2) . )

5. FE FTEAIXHEEREAIAILRE RTL Project, RIAFA IXE(ERA verilog {THMEAES Kwie. THEHY
Do not specify source at this time FNABAILIFT £, SNRAFT L , T—SSFNRI source file 57
E I

BEANPHK 5/ 44
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x|

Project Type

Specify the type of project to create ‘

o RTL Project
You will be abl

to add sources, create block designs in IP Integrator, generate IP, run RTL analysis, synthesis, implementation,
and analysis.

[] Do not specify sources at this ime
Post-synthesis Project: You will be able to add sources, view device resources, run design analysis, planning and
implementation.

Do not s at this time

1i0 Planning Project
Do not specify design sources. You will be able to view part/package resources.

Imported Project
Create a Vivado project from a Synplify, XST or ISE Project File.

Example Project
Create a new Vivado project from a predefined template

@ o | |||

6. BENIAIN source file RE , XBAEAPMUHAIRITE. M Next

x
Add Sources

Specify HOL, netlist, Block Design, and IP files, or directories containing those files, to add to your project. Create a new source ‘
file on disk and add it to your project. You can also add and create sources later.

i
+

Pl

Use Add Files, Add Directories or Create File buttons below

Add Files | | Add Directories | | Create File

s from subd

Target language: | Verilog ~ Simulator language: | Mixed ~

©) )

BEANPHK 6/44
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7. RTREMNEEHNARNY | XBLIRIAFABRBIRITYTF , AR,

x|
Add Constraints (optional)
Specify or create constraint files for physical and timing constraints. ‘
.
+
Use Add Files or Create File buttons below
Add Files | | Create File |
(2 i :
G “rre

8. TEHE FRAYXTIEEILEEFTAERY FPGA B84 , LN T —ECE. FPGA DRES—EERIRFIAIR
FRIBIS—EL, AX7035 FERIREISTAE Family 1=EB55E4E Artix-7, Speed grade 1=1&#%-2, 1£ Package 1=
0efE fggasd, PASRTE TEIRIFUZRTULRE xc7a35tfgga84-2 ; AX7050 FRARIREISTIE Family 1=EEiki¥
Spartan-7, Speed grade 1=1%#%-1, 7£ Package 1=1%1% fggad84, AFHE THEMIFIRPIEE
xc7s50fggad84-1 ; Bads NEXT HAT—FRHE :

Default Part

Choose a default Xilinx part or board for your project ‘

| Boards

Reset All Filters

Category: | All ~ Package: | fggdsd ~ Temperature: | All Remaining ~
Family Artix-7 - Speed -2 Static power. | All Remaining -
Search: Q- ~
Part /O Pin Count  Available IOBs  LUT Elements  FlipFlops  BlockRAMs  UliraRAMs  DSPs  Gb Transceivers  GTPE
xc7a15tfgg484-2 484 250 10400 20800 25 0 45 4 4
ic?a35ﬁggf-154—2 484 250 20800 41600 50 I 0 a0
xc7a501fgg484-2 434 250 32600 85200 75 0 120 4 4
Xc7ar5iigg484-2 484 285 47200 94400 105 0 180 4 4
xc7a100tfgg484-2 484 285 63400 126800 135 0 240 4 4
< >

AX7035 FFAHR FPGA

BEHIHK 7/44
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Default Part
Choose a default Xilinx part or board for your project. '

Parts | Boards

Reset All Filters

Category: | All [v3 Package: | fggad&4 £ Temperature: | All Remaining 3
Family: Spartan-7 ~ Speed: -1 - Static power. | All Remaining 3
Search: Q- “
Part IO Pin Count  Available I0Bs  LUT Elements  FlipFlops Block RAMs  UlraRAMs  DSPs  Gb Transceivers  GTPE
|| xc7s50fagadsd-1 484 250 32600 65200 75 0 | 120 0 0
XCTs75fggad84-1 484 338 43000 96000 a0 0 140 0 1]
XcTs100fggaddd-1 484 338 64000 128000 120 0 160 0 1]
< ?

@

AX7050 FFA& 1R FPGA

9. BIXPA— MR FELSHIRBIEY, i8R BRE Finish’5oh TI2EIE.

VlVADO / New Project Summary

HLx Editions
© AnewRTL project named ‘led_test will be created.

No source files or directories will be added. Use Add Sources to add them later.
No constraints files will be added. Use Add Sources to add them later.

0 The default part and product family for the new project:
Default Part xc7a35tfgg484-2
Product: Artix-7
Family: Artix-7
Package: fgg484
Speed Grade: -2

v
(A XI LI NX To create the project, click Finish

PROGRAMMABLE.

©

AX7035 FFA&HR FPGA

BEANPHK 8/44
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"

¢ MNew Project

|

VIVADQ! ~ MewProtect summary

HLx Editions
o Anew RTL project named ‘led_test will be created.

Default Part: xc7s50fggad84-1
Product Spartan-7

Family: Spartan-7

Package: fggad84

Speed Grade: -1

& XILINX

ALL PROGRAMMAEBLE.

©

To create the project, click Finish

o The default part and product family for the new project:

Mo constraints files will be added. Use Add Sources to add them later.

Mo source files or directories will be added. Use Add Sources to add them later.

AX7050 FFAHR FPGA

10. T2 R0 T EIR7R(AX7050 FFARR )

File Edit Flow Tools Window View  Help Q- Quick Access

Layout
=, RN >

Flow Navigator PROJECT MANAGER - |ed_test

~ PROJECT MAHAGER
Q Settings

Sources
a & +

Design Sources

Add Sources

Language Templates
guag P > Caonstraints

TF IP Catalog ~ Simulation Sources
sim_1
¥ IPINTEGRATOR
Create Block Design

Open Block Design

Generate Block Design

Hierarchy  Libraries Compile Order

¥ SIMULATION

Run Simulation Properties

~ RTL ANALYSIS

> Open Elaborated Design

iz

[ = 4

Project Summary

Settings  Edit

Project name:
Project location:
Product family.
Project part:

Top module name:

Targetlanguage:

Simulater language:

Synthesis

Status:
Messages:
Part:
Strategy:

Report Strateqy:

led_test
D:/Demofled_test
Spartan-7
xc7s50fggad84-1
Not defined
Verilog

Mixed

Mot started

N errors or wamings
xc7550fggadB4-1

Vivado Synthesis Defaults

Vivado Synthesis Default R

EEHHX
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42 RSifKKTRY verilog H3
1. )i Project Manager Y Add Sources Btk ( SEERBRIERE Alt+A )

File Edit Flow Tools Window Layoul View  Help Q- Quick Access
= L LI -

Flow Navigator 7 PROJECT MANAGER - lad_tast

¥ PROJECT MANAGER

Sources 2 _ 00X Project Sumimany

& Seltings
Q s + -

s

Design Sources

M4

Language Templales s Constraints Project name:
T P catalog ~ = Simulation Sources Project location
sim_1 Product family;
¥ IPINTEGRATOR Project part:
Creale Block Design Top module name:
. Targetlanguage:
- ) Simulator language

Hierarc Libraries  Compile Order

v SIMULATION fy | tor ! i
Run Simulation Pr ey = or x Status: Nal
o Messages: Mo
¥ RTL AMNALYSIS Part xc?
» Open Elaborated Design — Strateqy: Wivi

\, . \,
2. 175548 Add or create design sources 1510 , A Next,
A 4dd Sources x|
Add Sources
[
VlVADO This guides you through the process of adding and creating sources for your project

HLx Editions

Add or create constraints

I #) Add or create design sources I

Add or create simulation sources

& XILINX

ALL PROGRAMMARLE.

©) By —

BemhttX 10/ 44
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3. /Mifs Add Files BJLURIMES S , st AddDirectories AJ LR BRiAMINESASE, EAIMEFREIIE
EBERITER , IXBEERTE Create File %51,

A Add Sources x|

Add or Create Design Sources

Specify HDL, netlist, Block Design, and IP files, or directories containing those file types to add to your project. Create a new source file an ‘
disk and add it to your project.

+

Fl

Use Add Files, Add Directories or Create File buttons below

Add Files | | Add Directories Create File

@

TR HAIXHEHEER ISR File type 2 verilog, File name A led_test, sty OK #%4H,

#  Create Source File x

Create a new source file and add it to your project.

4

File type: @ Verilog v
File name: led_test

File location:  « =Local to Project= w
P

[ =

2 I 0K Cancel

4. =25 “Finish” 52k,

BEMIHK 11/44
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#  Add Sources

Add or Create Design Sources
Specify HOL, netlist, Block Design, and IP files, or directories containing those file types to add to your '

project. Create a new source file on disk and add it to your project.

+,
Index Mame Library Location
[ ] 1 led_testwv ¥il_defaultlic  =Local to Project=
Add Files ‘ | Add Directories Create File
Scan and add RTL include files into project

Copy sources into project

Add sources from subdirectories

@ Next = FEinish ‘ Cancel |

EX 1/0 B, XEF(TTLUAREN , [BEHE CEEFTRSHMALL BT OK 58

— A
[SSRRE
.

A Define Nodule |

Define a module and specify /0 Pors to add to your source file.

For each port specified:
MSBE and LSB values will be ignored unless its Bus column is checked.

Parts with blank names will not be written.

Module Definition

Module name: | led_tes{

0 Port Definitions

-

Part Mame  Direction Bus MSB LSB

input

12 /44
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N Define Nodule X|

o The module definition has not been changed.
Are you sure you want to use these values?

IXHAFTE Project Manager 52 FHY Design Sources BEZRE T — led_test.v {4, FBE BRI
BHETNE ( Top ) &7,

File Edit Flow Tools Reports Window Layout View Help Q- Quick Access
=, B X > B & = ¥
Flow Navigator c2 B PROJECT MANAGER - led_test
PROJECT MANAGER
r I Sources 2 _ 00 % Project Summary
'ﬂ‘ Settings - N ) _
Q = = + L o Overview | Dashboarc

Add Sources

w | __Design Sources (1)
Language Templates | ® -~ led_test (led_testv) Settings  Edit

IF |P Catalog » [ Constraints Project name:
v Simulation Sources (1)

Project location:
v P INTEGRATOR > sim_11(1) Product family:

Create Block Design ’ Utility Saurces Project part:

Top module name:
Open Block Design B
Target language:

Generate Block Design . i
Simulator language:

Hierarchy  Libraries Compile Order

v SIMULATION
Synthesis
Run Simulation
Source File Properties ? _ 00 %
Status:
> RTL ANALYSIS ® led_festy o Messages:
Reag-oniy: NO ~ T
> Open Elaborated Design ar
Encrypted: Mo Strategy:
~ SYNTHESIS Core Container. Mo BEDHESHAIEOY,
- Incremental synthesis:
P Run Synthesis |_| Global include
> Open Synthesized Design
Used In DRC Violations
— - .- . hed
~ IMPLEMENTATION S x
General Properties
P RunImplementation

5. BTNERKNRIRS led_testv RIRER IXBRATEN 7— 32 (IHFFRE timer, FAFEIRTEL
0~199_999_999(4 #b¥f), Zit#iE| 49999 999(1 # ) AUBE , ¥RKE— LED KT ; ZHit#E!
99_999_999(2 ) RIRHE , XEKE AN LED KT ; Z5itE4E 149_999_999(3 #> ) AURHE , ¥ERE=
AN LED T ; ZHiH#4E) 199_999_999(4 # ) AUBHE , XSREBIUA LED KT, iHERRBEMIHEL, BIX
AR FERERIEE,

BEMIHK 13 /44
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“timescale 1ns / lps

module led test

(
sys_clk, // system clock 50Mhz on board
rst n, // reset low active
led // LED,use for control the LED signal on board
);

//

// PORT declarations

//

input sys_clk;

input rst n;

output [3:0] led;

//define the time counter

// when the reset signal valid,time counter clearing

//4 seconds count(50M*4-1=199999999)

//count done clearing the time counter

//timer counter = timer counter + 1

//when the reset signal active

reg [31:0] timer;
reg [3:0] led;
//===z=z===zzz=zzzzzzzzzsszszszszozoasas
// cycle counter:from O to 4 sec
//=====z=z==zzz=zzzzzzzzzsszszszszozoasas
always @ (posedge sys clk or negedge rst n)
begin
if (~rst _n)
timer <= 32'd0;
else if (timer == 32'd199 999 999)
timer <= 32'd0;
else
timer <= timer + 1'bl;
end
//===z=z=z2=2z=2z=z=z=z=z2222z22222323222
// LED control
//===z=z=2z2=2z=2z=z=z=2=z2222z22222223222
always @ (posedge sys clk or negedge rst n)
begin
if (~rst n)
led <= 4'b0000;
else if (timer == 32'd49 999 999)
led <= 4'b0001;
else if (timer == 32'd99 999 999)
begin
led <= 4'b0010;
end
else if (timer == 32'dl149 999 999)
led <= 4'b0100;
else if (timer == 32'd199 999 999)
led <= 4'b1000;
end
endmodule

//time counter count to 1st sec LED1 lighten

//time counter count to 2nd sec LED2 lighten

//time counter count to 3nd sec,LED3 lighten

//time counter count to 4nd sec LED4 lighten

EEHHX

14/ 44
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6. MEIFHIEEIRE RH3ZE File -Save All Files,

4.3  #¥h0 XDC ERIEIRIS:

0 ISE ZK14A[E , Vivado ERRBVLISRIHHETNA xde 5. xdc B FEZE TR ERIAY
Y95 ATEPRYLTER, DARARIZIR, XBIEHAIBEIT led_testv FEFFHM NG HimOSEE!

FPGA FUESCEM L, IXEEEST— FPGA BB |BI4EESUY xde FHRINEI T2,

1. /5 Project Manager TNHYJ Add Sources Etx,

Eile Edt Flow Tools Window Layout Yiew  Help C

El b-‘ B o X
Flow Navigator C B B PROJECT MAMAGER - lad_test
* PROJECT MANAGER Sources - 0O x Project Sumimany
£ Setings
Q /e + b

Dasign Sourcas

Language Templates . Constaints Project name:
T P Catalog w = Simulation Sources Project location:
g sim_1 Product Family
¥ P INTEGRATOR Project part
Create Block Design Top module name:

Targel language:

Simulator Ianguagi

Hierarchy Libranas Compile Ordar

¥ SIMULATION Synthesis
Run Simulation Properties PR Status: e
o Messages ht
¥ RTL AMALYSIS pax -
* Qpen Elaborated Desian —- Bbrnbiarm

2. 1%64% Add or create constraints %I , =5 Next,

BemhttX 15/ 44
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N Add Seurces ﬂ

Add Sources

[
VlVADO This guides you through the process of adding and creating sources for your project
HLx Editions

I » Add or create constraints I

Add or create design sources

Add or create simulation sources

& XILINX

ALL PROGRAMMARLE.

(2) Sy—

3. |t Create File %58,

¢ Add Sources — -

Add or Create Constraints

Specify or create constraint files for physical and timing constraint to add to your project. ’
| Specify constraint set. | = constrs_1 (active) w
o+

Use Add Files or Create File buttons below

Add Files H Create File I

nstraints files into project

R HAIXTEIEERIEHEE File type 2 XDC, File name /9 led, /R OK $%4H.

BemhttX 16/ 44
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¢ Create Constraints File ﬂ
Create a new constraints file and add it to your
project ‘
Eile type: iy ¥DC w
File name: led
File location: | B0 =Local to Project= “
®
4. ;3R “Finish” 55k
¢ Add Sources *
Add or Create Constraints
Specify or create constraint files for physical and timing constraint to add to your project. '

Specify constraint set: constrs_1 (active) w
+,

Constraint File  Location

led.xdc =Local to Project=

Add Files

Create File

[:] Copy constraints files into project

&

Einizh | Cancel |

IXAITE Project Manager 52 FHY Constraints BRAY constrs_ 1 R FEEB 7 — led.xdc 314,

EEHHX
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File Edit Flow Toaols

= E

Fl

-

low Navigator = £

* PROJECT MANAGER
£} settings
Add Sources
Language Templates

T P catalog

7 IPINTEGRATOR

Create Block Design
Open Block Design

Generate Block Design

* SIMULATION

Run Simulation

* RTL AMALYSIS

> Open Elaborated Design

7 SYNTHESIS

P Run Synthesis

» Open Synthesized Design

7 IMPLEMEMNTATION

Window Layout View Help

Q- LluICK ACCeSS

X b, B & X ¥

PROJECT MANAGER - led_test

Sources 2?2 _ 00 X
Q T & + -
e Design Sources (1)
@ = led_test (led_testy)
w Constraints (1)
W oconstrs_1 (1)
I ledxdc

W Simulation Sources (1)
> sim_1 (1)

’ Utility Sources

Hierarchy @ Libraries Compile Qrder

Source File Properties 2?2 _ 00 X

I ledxdc 4= o
Encrypted: Mo A

Core Container: Mo

Used In

Synthesis

Implementation

General Pronertias

Project Summary b

Overview | Dashboar

Settings  Edit

Project name:
Project location:
Product family:
Project part:

Top module name:
Target language:

Simulator language:

Synthesis

Status:
Messages:
Part:

Strategy:
Repaort Strategy:

Incremental synthesis

DRC Violations

5. WEFTFFIXA™ led.xde M, TEXANSUEEZINLATRISIBIRESL ( LL AXT050 JFAMAH ) o

EEHHX
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set_property CFGEVS VOC0 [current_design]
set_property CONFIG_VOLTAGE 3.3 [current_design]

________________ Conficurate Settipehisspssssoiisnsus

set_property BITSTREAM. CONFIG. SPI_BUSWIDTH 4 [current_design)]
set_property CONFIG MOIE SPIx4 [curremt_design)]
set_property BITSTREAM. CONFIG. CONFIGRATE 50 [current_design]

_____________ Toel Tatitn

create_clock —period 20 [get_ports sys_clk]
set_property IOSTANDARD LVCMOS33 [get_poxrts {svs_clk}]
set_property PACKAGE PIN P15 [get_ports {svs_clk}]

set_property I0STANDARD LVCMOS33 [get_ports {rst_n}]
set_property PACKAGE PIN AR2 [get_ports {rst n}]

set_property PACKAGE PIN H16 [get_ports {led[0]}]
set_property [0OSTANDARD LVCMOS33 [get_poxrts {led[0]}]

set_property PACKAGE PIN G16 [get_ports {led[1]1}]
set_property [0STANDARD LVCMOS33 [get_ports {led[1]}]

set_property PACKAGE PIN K15 [get_ports {led[2]}]
set_property [0OSTANDARD LVCMOS33 [get_ports {led[2]}]

set_property PACKAGE PIN J15 [get_ports {led[3]}]
set_property [OSTANDARD LVCMOS33 [zet_ports {led[3]}]

XDC M/4HHIEMAEE.E CFGBVS ERIRIEBEEERIKABEE , RAEH &R E CFGBVS &
B2 ERiE 3.3V AY , tBEL2E BANKO By vecio, BIMICERIAIRER 3.3V, FILAXBE D IBCERK
VCCIO ﬂ] 3.3V,

TERNME—TREAR X0 RENEL , TiB 10 ARFBLIRS [HSTIBRE , SHLERAT
set_property PACKAGE_PIN "S|HI4RS" [get_ports “IROIRFR" |

FESESHLIRANT -
set_property IOSTANDARD "HB[E" [get_ports “IRIBTR" ]

XEFEIBNFIANNEG | mOSMREEENEREER | mOBARGIATER S
27—, BmOBRFAEMNKET .

A A AT LATE MRS EIHALUZR | EUANFe(i e XDC BBEE X T B NRIZE D B PAIRT I HA
79 20ns, BYSREIRBRUEISRTSIAANT ¢

create_clock -period "EJHA" [get_ports “ImOIRFR"

SeEIEIREEER File->Save all files {R1ZRIE 14,

BemhttX 19/ 44
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/A Run Synthesis , BIB]FHRERE FAERMMZRIS

File  Edit Flow Reports  Window  Layout  Wiew  Help Q- Quick Access
m, « BE B X > B & = ¥
Flow Navigator r 8 PROJECT MANAGER - led_test
~ PROJECT MANAGER
Sources 2 00O %
'ﬁ' Seftings - -
a = £ + &
Add Sources
W Design Sources (1)
Language Templates @ . led_test (I2d_festy)
T IP Catalog ~ Constraints (1)
w constrs_1 (1)
~ IP INTEGRATOR [ ledxdc
Create Block Design v Simulation Sources (1)
» sim_1(1)
Open Block Design
? ? > Utility Sources
Generate Block Design
v SIMULATION Hierarchy = Libraries Compile Order
Run Simulati
un simuiEien Source File Properties _Oorm x
¥ RTL ANALYSIS L fed.xde o
Encrypted: Mo -
» Qpen Elaborated Design
Core Container: Mo
W
SYNTHESIS Used In
P Run Synthesis
v [+] Synthesis
5 ) )
Open Synthesized Design Implementation
W
v IMPLEMENTATION .

1E Tcl Console BOEE Messages B ARILAEE—LIRZES

EEHHX

General | Properties

=

B/
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¥ |P INTEGRATOR

Create Block Design

" ledxdc

w Simulation Sources (1)

» sim_1(1)
Open Block Design
F . b Utility Sources

Generate Block Design

Hierarchy = Libraries Compile Order
v SIMULATION
Run Simulation
Source File Properties 2 _ 0O x>
! led.xdc
v RTL AMALYSIS L - o
Encrypted: IO o

» Open Elaborated Design
Core Container. Mo

¥ SYNTHESIS Used In

P Run Synthesis
y Synthesis

» (Open Synthesized Design Implementation

W
~  IMPLEMENTATION R S S L
General Properties
P Run Implementation
> OpenImplemented Design TciConsole |x Messages |Log | Reports | Design Runs

s -

¥ PROGRAM AMD DEBUG ;

E E @

INFO: [IP_Flow 19-2313] Loaded Vivado IP repository DMl
o .

l” Generate Bitstream file mkdir I:/w1linx_tes/led test/led test. sres/sources_1/ne

> Open Hardware Manager close [ open I:/xilinx_tes/led test/led test. sres/sources 1/
add files I:/xilinx tes/led test/led test. sres/sources_1/mew
update_compile_order —fileset zources_1

file mkdir I./xilinx_tes/led_test/led test. sres/constrs_1
file mkdir IZ,fxi].iru(_tesfled_testf].ed_test. srcsfconstrs_lfne

elase [ anen T Ffxiline tesfled testfled test srosfoonstrs 1/

GZExkE ETERBENAG LASER Synthesis Complete, B LARIXEHR Run
Implementation SEFFAT B4k :

EEHHX
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File  Edit Flow Tools Reports  Window  Layout  View  Help Q- Quick Access ISynthesis Complete {/
=, = LU I - BN )4 2= Default Layout -
Flow Navigator 3 e RS PROJECT MAMAGER - led_test ? %
st
¥ P INTEGRATOR Sources ? 00 X led test4 » = 2 O [&
Create Block Design Qa = = + 0 o iilinx_tesfled_testled
Open Block Design 5 = Design Sources (1) 2 a - »
ock i onstraints (1 :
Generate Block Design > O Al
|~ [ _Simulation Sources (10 v 0 '/ Module meme: |
Hierarch Libraries ~ Compile Order !
v SIMULATION Y ° 3G
4 “timescale ins
Run Simulation o
Source File Properties 2 _0O0K X 5
&) module led_test
* led.xd -
v RTLANALYSIS I ledxde - bl Tt
Encrypted: Mo ™ g svs_eclk,
» Open Elaborated Design 9 rst_n,
Mnre Cantainer Ko hd o
_________________________________________________)___ LI 1Ed
v SYNTHESIS General  Properties 1 2; S bt
» Run Synthesis
TclConsole x Messages | Log | Reports | Design Runs 2 _ 0O
> Open Synthesized Design
Q = 2 I E B @
~ |MPLEMENTATION |_l_| INFO: [IP_Flow 19-2313] Loaded Vivado IP repository ' D:/H1line/Vivado/2019. 1/dataf1i ™
E file mkdir I:/xi1linx_tes/led test/led_test. sres/sources_l/new
Ib Run Implementation I  close [ open I:/wilinu_tes/led_test/led_test. sres/sources_l/new/led_test.v w ]
> Open Implemented Design E add_fi.].es [Z,l"xi.].im(_tesﬂed_testﬂed_test. srcsfsou.rces_lfnewﬂed_test.v
! update_compi.le_order —fileset sources_l
R i (PRSI B S (Y- [ UDRY ) (S (ISR ) [P U S — |

&k ESE FEREING _ EAER Implementation Complete, SAJG AT Generate Bitstream

BPRTEERY bit 344,

EEHHX
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File  Edit Flow Tools Reports  Window  Layout View  Help »llmplememation Complete |J
=, = oo > )4 Default Layout v
Flow Navigator = 8 PROJECT MANAGER - led_test ? X
¥ |P INTEGRATOR Sources ? 00X led_test = 2?2010
Create Block Design Q = £ + o Ipdliny_tesfed_testled.
Open Block Design 3 Design Sources (1) ~ Q - N
Generate Block Desig Constraints (1 T
Generate Block Design > (1) . N
| oo [ Simulation Sources (). M 5!
Hierarchy  Libraries Compile Crder o
¥ SIMULATION o=
4 “timescale lns
Run Simulation _ !
Source File Properties ? _ 00O % 2!
[ 1 medule 1ed_test
" ledxdc -
v RTLANALYSIS [ - b Tt
Encrypted: Mo A 8 svs_clk,
> Open Elaborated Design 9 rst m
Care Container ko hd o .
X _______ ) 10 led
~ SYNTHESIS General = Properties 1 2 5 ™
P Run Synthesis
TclConsole x Messages | Log | Reports | Design Runs 2 _0O0n0n
> Open Synthesized Desiagn
Q = £ Il B B @
¥ IMPLEMENTATION J launch runs synth 1 —jobs 4 A

P Run Implementation

> Open Implemented Design

v PROGRAM AND DEBUG

¥ Generate Bitstream

> Open Hardware Manager

+ [Thu Jul 25 18:01:01 2019] Launched synt

hol..

Fun output %11l be eaptured here: I:/xilinx_tes/led_test/led test. runs/synth_1/runm

launch_runz impl_1 —jobs 4

+ [Thu Jul 25 13:10:29 2019] Launched impl

1.

Bun output %11l be captured here: I:/xilimx_tes/led_test/led_test runs/impl_1/runme

<

Tvpe a Tel command here

bit ARG , FAITRTLAFTFF Project Summary TAHEIRY Table SREBHRF L SLFREIRRYSE
FRIE, A X ER led_test FRFFLVIREER , REEIT U MNEIR: LUT(EIKZE ) FF(Flip Flop 2
788 ) ., 10 (&M ) 0 BUFG(HIEH Buffer),

e Oy TITE ST e STgT

~ IMPLEMENTATION
P Run Implementation
~ Open Implemented Design
Constraints Wizard
Edit Timing Constraints
@ Report Timing Summary
Report Clock Metworks
Report Clock Interaction
Report Methodology
Report DRC
Report Noise
& Report Power

" schematic

~ PROGRAM AND DEBUG

M Generate Bitstream

< Fnahled

N Bl..
General Froperties

Tcl Console Messages Log Reports Design Runs | Methodology | Power Timing Utilization x
Q = = 4 Summary
13
Resource Utilization Available Utilization %
~ Slice Logic LuT 59 20800 0.28
~ 8lice LUTs (=1%) FF 38 41600 0.09
LUT as Logic (<1%) 10 [ 260 2.40
~ Blice Registers (=1%)
Register as Flip Flop (<1%)
LUTy 1%
~ Slice Logic Distribution FF 1%
~ Slice (1%) o 2%
I u T T T
SLICEM 1] 25 50 75 100

SLICEL

~ LUT Flip Flop Pairs (<1%)
LUT-FF pairs with one unused
fully used LUT-FF pairs

LUT-FF pairs with one unused -

utilization_1

Utilization (%)

EEHHX
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45 vivado {HESSIE

BETRENIAINAGT] | IHBFETR Vivado SREIHIRZAGIERZK KT FE IR THERFNFA IR
TERE—E. BALERIT !

1. 1% E Vivado (A EACE , A SIMULATION 5 Simulation Settings.

Fa
~ PROJECT MANAGER
Sources 2 _ O
& Settings - "
Q = £ +
Add Sources
» Design Sources (1)
Language Templates 3 Constraints (1)
iF |p catalog [ Simulation Sources (1)
b sim_11(1)
v P INTEGRATOR > Litility Sources

Create Block Design
COpen Block Design

Generate Block Design

Hierarchy  Libraries Compile Order

M SIMULATION

Run Simulati Simulation Settings...

Reset Behavioral Simulation

-
¥ RTLANALYSIS Reset Post-Synthesis Functional Simulation

> Open Elabor: Reset Post-Synthesis Timing Simulation

Reset Post-Implementation Functional Simulation
¥ SYMNTHESIS

Reset Post-Implementation Timing Simulation

P Run Synthesi. :
I SIIES I [+*] Synthesis

* i i .
Open Synthesized Design @) Implementation

2. £ Simulation Settings B IR TUI FEIRECE |, IXEIRER 50ms ( IRIEEEBRTIRE ) HER
FANIRE | B OK 5Ehk.
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¢ Settings X
Simulation
Project Settings oy Specify various settings associated to Simulation '
General TS oSS SSoSoooSoosoosoooooos
Simulation Target simulator: Vivado Simulator -
Elaboration simulator language: Mixed v
Synthesis
) Simulation set: sim_1 w
Implementation
Bitstream Simulation top module name: | led_test E
> IP
Tool Settings Compilation | Elaboration | Simulation | Netlist | Advanced
Project
xsim.simulate tcl post -
p IP Defaults
. I ¥sim.simulate runtime 50ms I
Board Repository
xsim.simulate.log_all_signals
Source File g-al-sla O
Display ¥sim.simulate.no_quit O
P LT P A e | hd
WebTalk
Help xsim.simulate.runtime
s Text Editor Specify simulation run time
3rd Party Simulators
» Colors “
@ || oK | | ‘ Cancel ‘ ‘ Apply | | Restore... ‘

3. IR S 44 , RRE Project Manager TNHY Add Sources ElfR 3% FEIREGETE Next,

File  Edit Flow

B

= -
rl

Flow Navigator

v PROJECT MANAGER

'I:' Settings

Add Sources

Language Templates

IF P catalog

v IP INTEGRATOR

Create Block Design
Open Block Design

Generate Block Design

v SIMULATION

Run Simulation

~ RTL AMALYSIS

Tools

> Open Elaborated Desigl

Window  Layout View  Help Q- Quick Access
b B X )4
]
> PRO
]
¢ Add Sources g

Add Sources

VIVADO!

HLx Editions This guides you through the process of adding and creating

sources for your project

Add or create constraints

Add or create design sources

* Add or create simulation sources

& XILINX

ALL PROGRAMMABLE.

©

Finish

Cancel

EEHHX
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4. R Create File AR BRI (&,

¢/ Add Sources

Add or Create Simulation Sources

Specify simulation specific HDL files, or directories containing HDL files, to add to yo
Create a new source file on disk and add it to your project.

Specify simulation set: sim_1 w

Use Add Files, Add Directories or Create File buttons below

ur project. ‘

TSR HARHEEPENA N ARIEF |, XERIARI vif_led_test,

Add Files Add Directories || Create File ‘l
Scan and add RTL include files into project
Copy sources into project
A rces from subdirectories
Include all design sources for simulation
@ = Back Mext = Einizh Cancel

#  Create Source File
Create a new source file and add it to your project. '
Eile type: @ Verilog w
File name: Ivtr_led_test ||
File location: & <=Local to Project= o

®

6. Mt Finish IZHIR(E],

x

EEHHX
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¢  Add Sources

Add or Create Simulation Sources

Specify simulation specific HDL files, or directories containing HDL files, to add to your project.

Create a new source file on disk and add it to your project.

Specify simulation set: sim_1 w
+,
Index Mame Library Location

[ ] 1 vif_led_testv  xil_defaulllib  =Local to Project=

Add Files | | Add Directories Create File

Scan and add RTL include files into project
Copy sources into project
Add sources from subdirectories

Include all design sgurces for simulation

® v [

| Cancel ‘

XEEASEARI0 10 Ports , /AT OK,

,..Ilefine Hodule

Define a module and specify /O Ports to add to your source file.

For each port specified:
MSB and LSB values will be ignored unless its Bus column is checked.
Ports with blank names will not be written.

Module Definition

Module name; | vif_led_tes{

10 Port Definitions

+
PortName Direction Bus MSB LSB

input

® KN

EEHHX
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S Define Bodule ]

For each port specified:

Ports with blank names will not be written.

Module name:

+ -

I Yes
PortName D

Define a module and specify /O Ports to add to your source file.

MSB and LSB values will be ignored unless its Bus column is checked.

ol Defiion

0 The module definition has not been changed.
1/0 Port Definitiol Are you sure you want to use these values?

No

X

input v

®

Cancel

£ Simulation Sources BRTZ T — I ZRI0RY vtf_led_test 344, XEHEFTFHHX NG, B

LAERIEEAE module ZRIENX , HEHIRHE.

EEHHX
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File  Edit Flow Tools Reports  Window  Layout  View  Help Q- Quick Access
=, B X >, ¥ & 3 X
Flow Navigator S e PROJECT MANAGER - led_test
et
~ PROJECT MANAGER -
Sources 2 _0O0G X Project Summary
£} settings - . _ _
Q = £ + : & Overview | Dashboard
Add Sources
> Design Sources (1)
Language Templates 3 Constraints (1) Settings  Edit
TP Catalog ~ Simulation Sources (2) Project name:
v sim_1 (2] Project location:
v IP INTEGRATOR @ . led_test (led_testy) Product family:
Create Block Design [ @ v ted test (af_led testy) | Project part
> Utility Sources anmuhi S ame
Open Block Design P ’
Target language:
Generate Block Design ! .
Simulator language:
Hierarchy  Libraries Compile Order
¥ SIMULATION
Synthesis
Run Simulation
Source File Properties 2 _ 0O X
Status:
vif_led_testwv .
¥ RTL AMALYSIS ® i led_ - o Messages:
Read-only: Mo ~ )
> Open Elaborated Desiagn FELE
Encrypted: Mo Strateqgy:
¥ SYNTHESIS Core Container:  No Report Strategy:
Incremental synthesis:
P Run Synthesis
Used In
> Open Synthesized Design _ _
|w] Synthesis DRC Violations
o

7. BIEBRNFEREIXA vif_led_testv MIHHIAE. BIREXBNIEMES | AISFELA)
X led_test tHER , i led_test R FARAERFRI—ERD . BARINSMANTTPATERE. FThka

B9 vif_led_test.v SZAFAIT :

‘timescale 1ns / lps
1177117117717717717711117117177177177177177777777771771771771177177171711711711717
// Module Name: vtf_led_test
1177117117717717717717177117177177177177177777777771771771771177177171711711711717

module vtf led test;
// Inputs
reg sys clk;
reg rst n;

// Outputs
wire [2:0] led;

// Instantiate the Unit Under Test (UUT)

led test uut (
.sys_clk(sys clk),
.rst n(rst n),
.led(led)

) ;

EEHHX
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initial begin
// Tnitialize Inputs
sys _clk = 0;
rst n = 0;

#1000;
rst n = 1;
// Add stimulus here
#20000;
// $stop;
end

always #10 sys clk =
endmodule

// Wait 100 ns for global reset to finish

~ sys_clk;

8. MEWFEREFE | vif_led_testv BEIEL TIXMBE Hierarchy ITRET , B FTEERITX G

led_test.v,

Flow Navigator S el PROJECT MANAGER - led_test
ot
> PROJECT MANAGER
Sources 2 _ 00O X
- - "
¥ P INTEGRATOR Q = £ + - &
Create Block Desian » [ Design Sources (1)
» Constraints (1)
Open Block Design
R Simulation Sources (1)
Generate Block Design N sim_1 (1)
v il lrrr_le-:l_test (wif_led_testwv) (1)
¥ SIMULATION @ uut:led_test(led testy)
Run Simulation » Utility Sources
¥ RTL AMALYSIS
5 o Bl b ________]
Open Elaborated Design Hierarchy Libraries Compile Order
¥ SYNTHESIS Source File Properties ? _ OO X
P Run Synthesis
4 ® i _led_testv = &
» Open Synthesized Design Head-only: Mo A
Encrypted: R [s]
¥ IMPLEMEMNTATION
Caore Container. Mo
P Run Implementation
~ Open Implemented Design Used In
Constraints Wizard Synthesis
W
Edit Timing Constraints _{ S >
T IpALan 30/44
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9. /1 Run Simulation &0 , E1%#E Run Behavioral Simulation, IXEBEEAIM— FMTARBBER
LT,

Flow Navigator s e PROJECT MANAGER - led_test
o
? PROJECT MANAGER
Sources ? _ OO X
¥ IP INTEGRATOR a = £ + o
Create Block Design » [ Design Sources (1

) > Constraints (1
Open Block Design
w Simulation Sources (1
Generate Block Design - sim_1 (1

w2 vitf_led_test (vif_led_testv) (1)

¥ SIMULATION @ uut: led_test (led_testy

» = Utility Sources

| Hun Behavioral Slmulatmn'

¥ RTL AMALYSIS
Run Post-Synthesis Functional Simulation

» Open Elaborate o ) . . A
Run Post-Synthesis Timing Simulation e Order

v SYNTHESIS Run Postimplementation Functional Simulation . —_
» Run Synthesis Run Post-implementation Timing Simulation
TR YI_ITU_IT oLy h 'n'
» Open Synthesized Design Head-only: Mo ~
Encrvoted: Mo

INRIRABHEIR | Vivado PRMAERMEFHATIFET .

10 BT EFRERNTE , FERMEERMENMEITRNLEIRER 50ms BRI,

>, B & X ¥ 14> o 10/ ms v |3 c
! SIMULATION - Behavioral Simulation - Functional - sim_1-wif_led_test
-

Scox Sour | _ O x Pr 2 _ OO vil_led_testv x| Untitled2 x

a xz s # Q # |Q H @ @ i s |4 M o 2 o

Name ~ Name ~ 49, 999, 999, 996 n=

~ 3 vif_led_test 10 sys_clk

1
2 uut 14 rstn 4 sys_clk
& albl > B led(3:0]

4 rstn

» B led[3:0]

FHTF LED[3 : OIEFRFHIRITAPIRSZAUAT BN |, MR X ECEHERT , EIXEWLN timer[31:0]312
gETb. IBEREl Wave FIZR (R Scope FRE FAY uut , BAFEIEEE Objects 5RE TAY timer ,
AR HHAY RIS R BRI Add Wave Window),

BemhttX 31/44



www.heijin.org ALIN?2

SIMULATION - Behavioral Simulation - Functional - sim_1 - vif_led_test

Scope Objects Untitled 2
Qa = = o Q & Q W & a 2 < |4 »l = 2 4
v @ vif_led_test wif_led_t. h sys_clk 0 Value

@ alol alol > 44 timer[31:0] 00z

> T led[3:0] 0

Add to Wave Window

Log to Wave Database

Goto Source Code

Radix 3

Eorce Constant...
Force Clock..

Remove Force

Default Radix 3

I
NINE timer B7R1E Wave BSRZRE L | (0 TFEF.

> ¥ o# T ¥ 4 » % s00us v| = ©

SIMULATION - Behavioral Simulation - Functional - sim_1 - vif_led_test

Scope Objects Untitled 2*
Q = = &4 Q 4 | W @ 9 X o« M o= o 4
Name Design L Mame
~ @if_led_test vif_led_t. 2 sys_clk
o uut led_test Hrstn
F 5
2 glnl alnl 5 2 timer31:0]
> [ led[3:0]

> W led[3:.0]

> W timer(3

11. [T FFRER] Restart IZEHEN—T , Bmdh Run AR, (FEMOC! ! 1) |, TLUER
(hERZSIRIHER.
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Window Layout View Run Help

LI - ) ¥ 14 »
l SIHULATIDH—EIehauinraISimulatinn—F&al—si 1-wif_led_tes
nestart
Scope Objects
|
Q = £ & RurtAll
Mame Design L Mame
w O wif_led_test vif_led_t. My sys_clk
1 uut led_test Hyrstn
@ albl glbl ¥ timer[31:0]
> [ led[3:0]

Untitled 2*

Q W @ @ X « KM = 2 o

R g__
—v—_g

Pl timer[31:0] 4 99 5 & g g 0000

S

HATTLAEE led BEESZE—2 1, UiBH LEDI~LEDA JTIEANEK,

46 TEFDERR

LIBIEARIFENGE |, FATTLUE bit K TEE FPGA S F™F , H—F LED LFRafTHY
R, TEHAER ZBIEEE MY |, 18 ITAG TREFFAINERE , REFAIRLE ( TERX
AX7035 FFARIRAVEMAERE] ) .
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> SIMULATION

Vv RTLANALYSIS

> Open Elaborated Design

> SYNTHESIS

v IMPLEMENTATION

P Run Implementation

> Open Implemented Design

1LPROGRAN AND DEBUG |

>

Hierarchy

Properties

@ wf_led_testv

v Enabled
Location:
Type:

Library:
<

¥ Generate Bitstre
v Open Hardware

Open Target

kitstream Settings... I

e

TTX | &
Hierarchy
Summary

@ uut: led

Waveform C

Libraries

D:/demq

Verilog

xil_def

Messages

-~
v

JEFRAERK bin 314, SERYRY bin HEREIEMCIERER] FLASH BESRAE , XEBE—Epm—T.

EEHHX
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‘.Settings X
Q-
Bitstream
~
Project Settings Specify various settings related to writing bitstream ‘
LT3
Simulation (@ configure additional bitstream settings.
Elaboration
X “~Write Bitstream {write_bitstream)
Synthesis
) tcl.pre E
Implementation
tcl.post
Bitstream P E
s P -raw_itfile
-mask_file
Toal Settings -no_pinary_bitfile
Project
! | oinfie v | |
IP Defaults
-readback_file
Source File
-logic_location_file
Display
-verbose
WebTalk
Mare Options
Help
» Texi Editor
3rd Party Simulator:
» Colors
_ -bin_file
Selection Rules \Write a binary bit file without header (_bin).
Shortcuts
Strategies ~
< >
@ o] Comon ] [ | [moson

BB =SB Generate Bitstream ZE % bit 0 bin ST/4,
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ry
pen Block Design B sim_1(2)
= B il _led_te
neérate Block Design @ uut;led
» Waveform O
#  SIMULATION

Hierarchy  Libranes

¥ RTL ANALYSIS

» (Open Elaborated Design .
@ Wif_led_testv
* SYNTHESIS
+ Enabled
v |MPLEMENTATION Location: D:/dem
P Run Implementation Type: Verilo
»  Open Implemented Design Library; il _ded

¥ PROGRAM AND DEE General  Froperties
% Generate Bitstream

TclConsole  Messages|
~ Open Hardware Manager

Q = | #

Hierarchy

Open Target

2. )35 Open target $%§H->Auto Connect , £ hardware 5RHE F&S 87 xc7a35t_0 ( AX7035 FFAHR )
3}, xc7s50_0 ( AX7050 FF&#R ) FUERR , BB JTAG IEZEEFE,

~ IMPLEMENTATION
» Run Implementation Select an object to see properies

> Open Implemented Design

~ PROGRAM AMD DEBUG

¥% Generate Bitstream

~ (Open Hardware Manager
Tcl Console » Messages Serial /O Links Serial 110

-
Program Dey £ Auto Connect s N B ® @
| Irts«' STEPS. WEITE_BITSTREAM. ARGS. BIN_FILE true [
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@wx_mmguwm TUSTZTEU0aET
ROJECT MANAGER i © There are no debug cores. Program device Refrash device
b Settings
Hardware ? _00C X wif_led_test.v * led_testv x
Add Sources
o = % & Di/demo_AX7050/2_led_testled_test sres/sim_1in
Language Templates
Mame Status
F IP Catalog Q - ¥ B B N
~ B localhost (1) Connected T
15 . sys_elk(sys_clkl,
B eilipntetRigiantiaans1 21800, Open '
INTEGRATOR 7o .¥st_nlrst_n),
~ i xc7s550_0(2) Programmed 16 led(Led)
Create Block Design .
o 2F XADC (Sysiem Monitar) 1 | %
20
Open Block Design ; i :
P g & mt25g11268-spi-x1 _x2_x4 2 initial begin
Generate Block Design d * 22, 4 Initiglize Inputs
23 sys_clk = 0;
Properties ?2 _00C X 24 rstn o= 0;
MULATION o
Run Simulation ﬁ 26 E A Weit 100 ns Far glabsl resat ta F
27 #1000,
I rst_n = 1;
TL AMALYSIS 2 A 434 stimulus hers
Open Elaborated Design a0 #20000:
Select an objectto see properties 3o A Fatap;
3E end
MTHESIS 33
Al #5 1k = ™ 1k; S5 ]
Run Synthesis 3 : Ways s¥5_c s¥5_c Si5RE

BHEGESE xc7a35t_0 ( AX7035 FFAAR ) B xc7s50_0 ( AX7050 FFAMR ) FESRH AUGEIER %

Program Device Iil,

- | =
PROJECT MANAGER - © There are no debug cores. Program device Refresh device
'ﬂ' Settings
Hardware 2 _ 00 % wif_led_testw x led]
Add Sources
Q =z = & D:/demo_AX7050/2_led |
Language Templates
Mame Status
TF |P Catalog Q -
~ [ localhost (1) Connected T
16 ! . sys_clk(=ys
~ @& xilink_tcfiDigilent2105121800...  Open '
IP INTEGRATOR . o .rst_n (x;t_n
Create Block Desian ~ B xc7s50 0 Hardware Device Properties... Citrl+E
g 5 ¥ADC (3
Open Block Design & mt25g1 |
LT
Verify Device... L .
Generate Block Design & '. Faliz
| ' Refresh Device =0
Hardware Device Propt o;
SIMULATION
7s50_0
Run Simulation & xc7s50_ Boot from Configuration Memory Device oo
Mame: xC Program BBR Key... -1
RTL ANALYSIS Clear BER Key B+ im
Part: piv
> Open Elaborated Design .
Program eFUISE Registers..
1D code: 0z
SYNTHESIS P | Export to Spreadsheet...
"""""""""""""""""""""""""""" ©oal #5
P Run Synthesis General  Properties 3t elways A

7E55HAY Program Device XTIEHER , 1554F led_test IRBAEAYAY bit & , ik Program #&%$H
155 FPGA,
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¢ Program Device

Select a bitstream programming file and download it to your hardware device. You can optionally
select a debug probes file that corresponds to the debug cores contained in the bitstream ‘
programming file.

| Bitstream file: Deidemo_AXT05012_led_testled_testrunsfimpl_1/led_test bit | |I|

Debug probes file: |I|

| Enable end of startup check

Pl
(?) Erogram Cancel

RS 5ERE xc7a35t_0 ( AX7035 FFA#R ) 8] xc7s50_0 ( AX7050 FFAHR ) BUIRESEST R
Programmed, IXB3EA TRJ AR EIFF AR EAIPYAN LED JT BEERURKTSMET .

Hardware ? _ 00 X wvif_led_testw ¥ led_testw  x
Q = = o Diidemo_AX7050/2_led_testled_test srcs/s
Mame Status
Q - ¥ B K
~ B localhaost (1) Connected ;
1B csws_cllklzys_clk),
~ @l xiling_tefiDigilent2105121800... Open o rst_nlrst_n),
I ~ {8} xc7550_0(2) Programmed I 1\ .led(1ed)
& XADC (System Monitor) 9o
20
% mt25q11 28-spi-xl _x2_xd - initial begin
\ ? e A Initigldiza Tnputs

(REFTLURERREERRS LED , tban , ibTEER—E , S/ M TRRSRERES ,
MEIRIESRNOT | BEECEEFEEAMHE , TETEBARRIRIRAZISEIRF | AT
e | 20 ?

4.7 FLASH fEFBEHE

ZERRRINTE Bit 4R FPGA f5 |, FAAIREHT LEEERERFEEEX
JITAG T, IXEARRR ! FFIE | X—THEAIRN B ERFECETT AR LAY FLASH 1,

XA MEBEEREXRT .
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ERNNFFEIR EB— 8rin B 128Mbit B9 FLASH, BT 1FiEBCETER. T CEEE Bit
MAHTEERXA FLASH /R, HBETE Bin 34 aE Mcs U4 |, TERIEFA 14K bit XAAYREIATHE
4RL T Bin 34, TELATE Bin FABIAKKRNEE FLASH FZRRAIEHL.

1. RN N EPAHRIERE xc7a35t_0 ( AX7035 FFA&RIR ) 8 xc7s50_0 ( AX7050 FFA&RIR ) SR , 138
AY%1ZRhi%kIE Add Configruation Memory Device...

Flow Navigator ? HARDWARE MANAGER - localhostxiling_tcfiDigilent’210512180081
¥ PROJECT MANAGER - o There are no debug cores. Program device Refresh device
'|:|' Settings
Hardware ? _0OC % wvif_led_testw » led
Add Sources
Q = £ ] Didema_AXT050/2_led,
Language Templates
Name Status
F |P Catalog Q -
~ E localhostil) Connected .
1B . sys_clkisy:
~ @l xiling_tefiDigilent’2105121800...  Qpen '
¥ IP INTEGRATOR 17 crst_n(rst_s
~ {8k xc7s50_0 (1) Programmed 12 . Jlediled)
Create Block Design S YADC Hardware Device Properties... Ctri+E
Open Block Desig
pen =ian Program Device... segin
Generate Block Design [ —— Verify Device.. Eitisli.
| Ak =0
Hardware Device Pr (& Refresh Device Lz
~  SIMULATION
{8 xc7s50 0 Add Configuration Memory Device... )
Run Simulation git 100
Boot from Configuration Memary Device 1:
Mame: cn=1
¥ RTL ANALYSIS Program BER Key.. 33 stim
Part:
*» Open Elaborated Design Clear BBR Key.. 0
. o
ID code: Program eFUSE Registers...
W P— .
SYNTHESIS ¢ I Exportto Spreadsheest...
ES !
P Run Svnthesis General Pronertigs EVE-

FE - R EMIRE AREAREEE , REARITRENTERCEH T FLASH BE , Rk
iRA0 FLASH , B0F -
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= =

@ There are no debug cores. Program device Refresh device

Hardware
Q =
Name

v B localhost (1)

v @
& XADC (System
| % mt25q1128-spid|

T

flash

Hardware Device Properties

{8 xc7a3200t_0

v @e xlinx_tcfDigilent’2105121800..  Open

2= BB

o

Status
Connected

Not proarammi
Hardware Device Properties...

Program Device...
Verify Device...

C' Refresh Device

Boot from Configuration Memory Device

Program BBR Key...
Clear BBR Key...

Program eFUSE Registers...

Exportto Spreadsheet...

Name: xc7a200t
Part: xc7a200t
ID code: 13636093

-

SAE CNREBEEA flash R LEFERNI— FEITER |, AR NERGER flash , A5

2 FERAN flash BOAEBHETADE] -

Mame

~ [ localhost (1)

~ ¢ [ 2)

~ @ wling_tcfDigilent2105121800...  Open

E XADC (System Monitor)
i mt2egl128-snivl ¥? vd

Status
Connected

Mot programm

Configuration Memory Dv

Configuration Memory Device Properties...

Femove Configuration Memory Device

Program Configuration Memory Device...

Readback Configuration Memory Device...

Exportto Spreadsheet...

Ctrl+E

Delete

& mt25g1128-spi-x1_x2_xa—" e ThF

2. £ Add configruation Memory Device BIECE R ISR IR FLASH BYE |, W B :

EEHHX
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led Configuration Memory Device

o Choose a configuration memaoary part. This can be changed later.

Device: {8 xc7a100t_0

X

Filte
Manufacturer | Micron A Type | Al v
Density (Mb) | 128 - Width | x1_x2_x4 LV
Reset All Filters
Select Configuration Memory Part
Search: | O,
Mame Part Manufact.. Alias Family Type Density (...
I i mt25ﬂ|128—sei—x1 ¥2 x4 mt259|128 I'nﬂcmn n255128—3.3v—spi—x1 %2 xd mt255| Spi 128 I
% mt25qu128-spi-x1_x2_xd mt25qu128 Wicron n25q128-1.8v-spi-x1_x2_x4 mi25qu 5pi 128
{ »
® | o |

3. IBTREEXT SPI FLASH IHT4RIZ . /b OK.

Add Configoration Hemory Device Completed

o Cio you want to program the configuration memory device now?

[] Dont show this dialog again

TE38HAY Program Configuration Memory Device B[94 , Configration file TZEHE Vivado 4EpKAY
led_test.bin 344 ( LESTAHERIATE impl_1 BRT ) . PRM File IRAAIE. BIMEXNMEORBFIER]

LAECE 1/0 LR, FREET LT, EERIFERREIARMAILL

EEHHX
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s oK FHALRE

FLASH {Ri25etefs |

Performing program operation - Step 2 of 2.

18%

SHHAN TR TIRISAE.

IS

¢ Program Flash

===

o Flash programming completed successfully.

'S

A

x
Select a configuration file and set programming options. ‘
Memory Device: {8 mi25g1128-spi-x1_x2_x4
I Configuration file: strunsfiimpl_1/led_test.bin ”Il I
PRM file:
State of non-config mem 'O pins: Pull-none wr
Program Operations
Address Range: Configuration File Only ~
~| Erase
Blank Check
~'| Program
| Werify
@ OK | Cancel ‘ ‘ Apply
FLASH,
¢ Program Configuration Memary Device M

Z|th , SPIFLASH JRE5SEE | led_test RRREAE{LE! SPI FLASH ARy, FRAIIKEIE—T , X8

EFEFTAR

FF—2 USRI LAERFF AR LAY LED TELEMEDIEE T,

EEHHX

42/44



www.heijin.org ALINX

ARERIAITY , XEREH LEFEFTF—=/L , FFARIR LRI LD T A SRR 5]
. XNBEL LB EMETFNRESERNHE 7 |, BMEIRAINAERIE | ZAER) , &
IETLARES SPI FLASH AUIEERIH , 55IMER x4 BIATVES | QSPI B35 4 IREIRZIESRIE |
FiEREER , FAIREE xde EHEIMALLT 3 &89 -

set_property BITSTREAM. CONFIG. SPT_BUSWIITH 4 [current_designm]
set_property CONFIG MODE SFIx4 [current_design]
set_property BITSTEEAM. CONFIG. CONFIGRATE 50 [current_design]

HogiERLIEE QSPl FLASH BUEUESEMRSE EE—%%@EEEJE , IXMEHK ,
BRERIR, 18K xdc MERFEEFRIF , BEHFAER bit #1 bin & , ARKRIENSEERS
—I& SPI FLASH . /T8, SSREFAR LR , XTEAR—LH , LED THMARMEz 7 IE ?

XENIE , FAINE—NMEHMEHTTH T, BEEEZEET Vivado B FPGA FRRRIENA
2, AR FPGA BRINIINXTIE | IHESE] | IBITEFTEREARS | vivado IRIHHI—LE
ISHYERZ E B R ARERIASTEAIRRTEERE T .

5 PBiFE

led_test.v(verilog {{A3)

‘timescale /
module led test
(

input sys_clk, // system clock 50Mhz on board
input rst_n, // reset ,low active
output reg[3:0] led // LED,use for control the LED signal on board

)i

//define the time counter

reg [31:0] timer;

// cycle counter:from 0 to 4 sec

always@ (posedge sys clk or negedge rst n)

begin
if (~rst_n)
timer <= ; //when the reset signal valid, time counter clearing
else if (timer == ) //4 seconds count (50M*4-1=199999999
timer <= ; //count done,clearing the time counter
else
timer <= timer + ; //timer counter = timer counter + 1
end

// LED control
always@ (posedge sys_clk or negedge rst_n)

begin
if (~rst_n)
led <= ; //when the reset signal active
else if (timer == ) //time counter count to 1lst sec,LEDl lighten
led <=
else if (timer == ) //time counter count to 2nd sec,LED2 lighten
led <=
else if (timer == ) //time counter count to 3rd sec,LED3 lighten
led <=
else if (timer == ) //time counter count to 4th sec,LED4 lighten
led <=
end
endmodule
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IR EEXTERE  MRSFREE always REERUAEN S reg KB, MRNERTF
ELHEEEMETEN wire KB, BAGSHIRBEAREEN D reg B, FERE reg RBUFS
ER wire RENES , EXHFEFREECTACERNNEE , BUARATFRSFTEEER
IR, SEXFEFRUSEEXFERBTRUSRESR , MREXENFERTER, W
DISAEIEEE , SHEFER. PEAEMGESHXBRRAEZFTAREE Verilog iEiEHIE.
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